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PhotoPat Description

PhotoPat is a truly unique Windows image processing package.    Bitmap images are read in 
(or transferred via the Window's Clipboard) and then converted into "color-by-number" 
patterns.    A sophisticated algorithm is used to optimally select pixels into appropriate color-
balanced pieces. B-spline based edge detection techniques are then used to construct the 
piece outlines.    A user-definable palette (with as many as 240 colors) is used in matching up
the regions.    The user is also able to control the number of pieces allowing for designs of 
different complexity.    The pattern may be customized by several means including line color 
and style, font selection, and a grid.    A selection of palettes and sample images are 
provided.    Various scaling options are available when printing allowing for poster-size 
output.    Patterns can be saved as bitmap images (in a BMP format) or as vector output (in 
HPGL and DXF formats) 

Patterns generated by PhotoPat are extremely photo-realistic, making them quite different 
for those found in Children's "color-by-number'" kits.    PhotoPat patterns can use colors from 
the entire set of crayons, making the spectrum of available shades and tints much greater 
than an 8-color kit.    Because PhotoPat "averages" and "optimizes" the color matching, the 
resulting drawn pictures closely match the original image.

Drawing the pattern is quite a challenge and makes for an entertaining puzzle.    It can take 
up to an hour to carefully draw in the pattern, during which time your child (or even you!) 
will be totally immersed, particularly if the pattern has some relevance (like a picture of 
him/herself).

Applications for PhotoPat include "color-by-number" designs and puzzles, sign making, stain-
glass design, needle craft work, etc.

PhotoPat has been designed to be a well behaved Windows Application making it easy to 
learn and use.    Features include a simple setup program, context sensitive help, standard 
looking Windows menus with dialogs, a toolbar, a status bar, and clipboard support.

To create a pattern, open up a 256 color BMP image (or copy one in from the clipboard) and 
select Pattern/CREATE PATTERN!! .    In moments the pattern will be displayed on your 
screen.    You are then able to print the pattern out (along with a color chart), or save it to a 
256 color BMP image file.

PhotoPat 1.5 is a product of Rainbow Scan, Inc.
Copyright © 1994    All Rights Reserved.

Freely distributed installation compression program is LHARC:
LHA's SFA 2.13S © Yoshi, 1991



Detail Areas

Detail areas are regions in the image which contain important visual information that you 
may want to preserve (or emphasize) during the process of creating a pattern.    To define an 
area, simply hold the left mouse button down and drag the cursor so that a detail area is 
drawn.    Many detail areas can be defined over the same image.



Creating a Palette

A palette is a set of colors that you want to make a pattern with.    When the pattern is 
created, the colors of the pieces are matched to the closest palette color.    There is always a 
current palette which is used when running PhotoPat.    To create a new palette select 
PALETTE/NEW from the menu.    To modify the current palette select PALETTE/EDIT.    To 
change the current palette select PALETTE/OPEN.    Note that changing the palette will 
remove all existing patterns.

The file extension for PhotoPat palettes is ".PAL".    The format of this file is unique to 
PhotoPat.

Colors in the Palette may be added to the end (ADD COLOR),    inserted in the middle (INSERT
COLOR), or deleted (DELETE COLOR).    A palette color can be moved to by single clicking 
and edited by double clicking.    To add a color, the color name, identifier, and definition need
to be specified.    The color name is used as a description when the palette (and other 
reports) are printed out.    The identifier is used as identification on the pattern.    The 
definition describes the color (either a Red-Green-Blue or Hue-Saturation-Luminous scale 
may be used.)



Using PhotoPat with Microsoft Paintbrush

Microsoft Paintbrush is a general painting program which is included with the Windows 
release.    It is generally found in the Accessories Group.

You can use Paintbrush as a quick way of coloring in the patterns.    This makes for a fun and 
creative puzzle.

When you create a pattern in PhotoPat do the following:
o    Set the line style in the Design Pattern dialog to a solid thick line.    This will allow you to 
use the paint roller in Paintbrush to fill in the pieces.

o    If you want to "color-by-number" with the colors in Paintbrush, create the pattern using 
pbrush.pal as the palette.    Also make sure the color ids are displayed and the pieces are not
displayed.    The colors in Paintbrush are numbered going left-to-right, top-to-bottom:
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o    If you don't want to "color-by-number" in Paintbrush, make sure the color ids are not 
displayed and the pieces are not displayed.    You can have some creative fun filling in the 
pieces with random colors.

o    Use the Clipboard to transfer to image over to Paintbrush and color in using the paint 
roller.    Be careful not to color the outline!



Coloring with Crayons

Here are some tips when coloring with crayons:

o    You can easily make poster size prints by scaling.    This will help by enlarging the 
smallest pieces.

o    Keep the crayons sharp.

o    Print out the Palette so that you have an easily accessible list of the crayon colors and 
their ids.

o    Divide the crayons into groups of 16 (typically how they are packaged anyway) and color 
one group at a time.

o    Have fun!



File menu commands

The File menu offers the following commands:

New Creates a new image. 
Open Opens an existing image.    Both BMP and PCX file formats may be 

opened.
Close Closes an opened image.
Save Saves an opened image using the same file name.
Save As Saves an opened image to a specified file name.
Print Brings up the print dialog where you can select to print the image, the

pattern, and/or several reports.
Print Preview Brings up the print dialog where you can select to preview the image, 

the pattern, and/or several reports as they would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits PhotoPat



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous image modifying operation.
Copy Copies the entire image to the clipboard..
Paste Replaces the current image with the image in the clipboard.
Delete 
Pattern

Deletes the generated pattern.    The image remains the same.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Pattern Shows or hides the pattern.
Image Shows or hides the image.

Image menu commands

The Image menu offers the following commands:

Flip Vertical Flips the image about its center vertical axis.
Flip Horizontal Flips the image about its center horizontal axis.
Rotate 90 Degrees Rotates the image 90 degrees counterclockwise.
Rotate 180 Degrees Rotates the image 180 degrees counterclockwise.
Rotate 270 Degrees Rotates the image 270 degrees counterclockwise (or 90 

degrees clockwise).
Crop Crops the image to the selected region.    
Brightness/Contrast Allows you to adjust the brightness and contrast in the 

image.
Blur Blurs the image.
Sharpen Sharpens the image.
Edge Detection Emphasizes edges in the image.
Emboss Embosses the image.
Gray Scale Converts the image to gray scale colors.
Invert Colors Inverts the colors in the image
Resample Allows you to resample (change resolution) of the image.
Information Displays information about the image.
Zoom 25% Zooms the image by 25%
Zoom 33% Zooms the image by 33%
Zoom 50% Zooms the image by 50%
Zoom 100% Zooms the image by 100%
Zoom 150% Zooms the image by 150%
Zoom 200% Zooms the image by 200%
Zoom 250% Zooms the image by 250%
Zoom 300% Zooms the image by 300%
Zoom 400% Zooms the image by 400%
Zoom 600% Zooms the image by 600%
Zoom 800% Zooms the image by 800%



100% - No Zoom Display the image at normal resolution (no zoom)
Zoom In Zooms in on the image by one step
Zoom Out Zooms out of the image by one step.

Pattern menu commands

The Pattern menu offers the following commands, which enable you both create a pattern 
and design several features of it as well.

CREATE PATTERN! Creates a pattern for the image.
Design Pattern Allows you to design various pattern features.
Statistics Display information about the pattern.
Save Pattern As Lets you save the pattern in one of several formats.



Palette menu commands

The Palette menu offers the following commands, which enable you to design and select 
palettes to match your pattern with.

New Creates a new palette.
Open Opens an existing palette.
Edit Allows you to edit the colors in the current palette
Print Prints the current palette
Save Save the current palette
Save As Saves the current palette to a specified file name.



Reports menu commands

The Reports menu offers the following commands, which enable you to print reports about 
your palette and pattern.

Palette Prints a report of the palette (identifiers and colors).
Colors Prints a report showing the colors used in the pattern.
Pieces Prints a report showing the pieces in the pattern

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple images in PhotoPat

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Registration Provides information on registering PhotoPat
Distribution Explains how you can distribute PhotoPat
Disclaimer Disclaimer on PhotoPat
Shareware Explains what Shareware is
Credits Gives credit where credit is due
Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
Search for Help 
On...

Allows you to search for topics based on key words. 

About Displays the version number and registration information 
for PhotoPat.



New command (File menu)

Use this command to create a new image in PhotoPat.    You can open an existing document 
with the Open command. Bitmaps may be copied into the new image from the clipboard,

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing image in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open images.    
See Window 1, 2, ... command.

You can create new images with the New command.

Shortcuts

Toolbar:
Keys: CTRL+N



Print command (File menu)

Use this command to print the active image and pattern .    The print choices dialog will 
come up.

The printed page will match the display at the time of printing.    You can control what is 
displayed by using the View menu.    

Shortcuts

Toolbar:
Keys: CTRL+P



Print Preview command (File menu)

Use this command to preview what a the printed pages would look like.    The print choices 
dialog will come up.

While you are previewing, you are able to view two pages at a time.    You can zoom in on the
previewed pages as well.



Print Setup command (File menu)

Use this command to set up the active printer.    Pages printed from PhotoPat will be directed 
to this printer



Close command (File menu)

Use this command to close the active image .    PhotoPat suggests that you save changes to 
your image before you close it.    If you close an image without saving, you lose all changes 
made since the last time you saved it.    Before closing an untitled image, PhotoPat displays 
the Save As dialog box and suggests that you name and save the image.

You can also close an image by using the Close icon on the image's window, as shown below:



Save command (File menu)

Use this command to save the active image to its current name and directory.    When you 
save an image for the first time, PhotoPat displays the Save As dialog box so you can name 
your image.    If you want to change the name and directory of an existing image before you 
save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active image.    PhotoPat displays the Save As 
dialog box so you can name your image.    

To save an image with its existing name and directory, use the Save command.



Exit command (File menu)

Use this command to end your PhotoPat session.    You can also use the Close command on 
the application Control menu.    PhotoPat prompts you to save images with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
image files you closed.    Choose the number that corresponds with the image you want to 
open.



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last image editing action, if possible.      The name of the 
command changes, depending on what the last action was.

The last 30 operations may be undone.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Copy command (Edit menu)

Use this command to copy the entire image onto the clipboard.    Copying data to the 
clipboard replaces the contents previously stored there.    PhotoPat uses a CF_BITMAP 
clipboard format for the image which is widely accepted by other image/paint programs 
including Paintbrush

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to replace the current image with a copy of the clipboard contents.    This 
command is unavailable if the clipboard is empty.    PhotoPat accepts both CF_BITMAP and 
CF_DIB clipboards formats which are commonly used formats for images.

Shortcuts

Toolbar:
Keys: CTRL+V



Delete Pattern command (Edit menu)

Use this command to delete the pattern associated with the image.    This command is 
unavailable if no pattern has been generated.

Several operations will also cause the pattern to be deleted:
Changing the palette.
Resampling the image to a different resolution.

This operation cannot be undone.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in PhotoPat, such as File Open.    A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Pattern command (View menu)

Use this command to display and hide the Pattern.    If no pattern has been generated, then 
this command will be disabled. A check mark appears next to the menu item when the 
Pattern is displayed.

Shortcuts

Toolbar:



Image command (View menu)

Use this command to display and hide the Image. Hiding the image when the pattern is 
visible allows for better viewing of the pattern. A check mark appears next to the menu item 
when the Image is displayed.

Shortcuts

Toolbar:



Flip Horizontal command (Image menu)

Use this command to flip the image about its center horizontal axis.    

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Flip Vertical command (Image menu)

Use this command to flip the image about its center vertical axis.    

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Rotate 90 Degrees command (Image menu)

Use this command to rotate the image about its center point by 90 degrees 
counterclockwise.    

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Rotate 180 Degrees command (Image menu)

Use this command to rotate the image about its center point by 180 degrees 
counterclockwise.    

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Rotate 270 Degrees command (Image menu)

Use this command to rotate the image about its center point by 270 degrees 
counterclockwise.    

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Crop command (Image menu)

Use this command to crop the image using the selected region as the new contents.    If no 
region is selected, this command is disabled.    A region is selected by holding down the left 
mouse button and dragging a rectangular area.

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Brightness/Contrast command (Image menu)

Use this command to adjust the Brightness and Contrast in the image.    The 
Brightness/Contrast dialog will come up.

You can undo this operation by selecting the Undo button .



Blur command (Image menu)

Use this command to blur the image.    Blurring results in a smoother looking image and 
reduces the amount of color changes from pixel to pixel.

You can undo this operation by selecting the Undo button .



Sharpen command (Image menu)

Use this command to sharpen the image.    Sharpening results in a crisper looking image and
enhances the color changes from pixel to pixel.

You can undo this operation by selecting the Undo button .



Edge Detection command (Image menu)

Use this command to edge detect the image.    Edge Detection emphasizes any edges in the 
original image.

You can undo this operation by selecting the Undo button .



Emboss command (Image menu)

Use this command to emboss the image.    Embossing creates a raised up effect in the 
image.    The image looks as if it consists of 3-D layers of metal or stone.

You can undo this operation by selecting the Undo button .



Gray Scale command (Image menu)

Use this command to convert the image to gray scale.    The image will be displayed using 
colors along the gray scale (black to gray to white).

You can undo this operation by selecting the Undo button .



Invert Colors command (Image menu)

Use this command to invert the colors in the image.    The colors are inverted based on a 
RGB red-green-blue scale.    For example a pixel with a color of all red, no green, and all blue 
(magenta) will be changed to no red, all green, and no-blue (green).    This can create some 
bizarre and fun effects.    Inverting the image twice will return to the original image.

You can undo this operation by selecting the Undo button .



Resample command (Image menu)

Use this command to change the resolution of the image.    The Resample Dialog will come 
up.

The pixel's color information is averaged into the new pixels in the resampled image.    The 
resampling can be done in either the x (width) or y (height) or both direction(s) and doesn't 
have to be proportional in both directions.    This can create some interesting scaling effects.

You can undo this operation by selecting the Undo button .



Information command (Image menu)

Use this command to bring up the Image Info dialog.The information displayed includes 
resolution, color, and original format.



Zoom 25% command (Image menu)

Use this command to zoom in 25% on the image.

You can undo this operation by selecting the Undo button .



Zoom 33% command (Image menu)

Use this command to zoom in 33% on the image.

You can undo this operation by selecting the Undo button .



Zoom 50% command (Image menu)

Use this command to zoom in 50% on the image.

You can undo this operation by selecting the Undo button .



Zoom 100% command (Image menu)

Use this command to zoom in 100% on the image.    The image is display without any 
scaling.

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Zoom 150% command (Image menu)

Use this command to zoom in 150% on the image.    The image is display without any 
scaling.

You can undo this operation by selecting the Undo button .



Zoom 200% command (Image menu)

Use this command to zoom in 200% on the image.

You can undo this operation by selecting the Undo button .



Zoom 250% command (Image menu)

Use this command to zoom in 250% on the image.

You can undo this operation by selecting the Undo button .



Zoom 300% command (Image menu)

Use this command to zoom in 300% on the image.

You can undo this operation by selecting the Undo button .



Zoom 400% command (Image menu)

Use this command to zoom in 400% on the image.

You can undo this operation by selecting the Undo button .



Zoom 600% command (Image menu)

Use this command to zoom in 600% on the image.

You can undo this operation by selecting the Undo button .



Zoom 800% command (Image menu)

Use this command to zoom in 800% on the image.

You can undo this operation by selecting the Undo button .



100%-No Zoom command (Image menu)

Use this command to zoom in 100% on the image.    The image is display without any scaling

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Zoom in command (Image menu)

Use this command to zoom in on the image to the next scale factor:

At this 
factor

New scale 
factor

25% 33%
33% 50%
50% 100%
100% 200%
200% 300%
300% 400%
400% 600%
600% 800%

At 800% the image is zoomed in as far as it can and this option is unavailable

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



Zoom out command (Image menu)

Use this command to zoom out on the image to the next scale factor:

At this 
factor

New scale 
factor

33% 25%
50% 33%
100% 50%
200% 100%
300% 200%
400% 300%
600% 400%
800% 600%

At 25% the image is zoomed out as far as it can and this option is unavailable.

You can undo this operation by selecting the Undo button .

Shortcuts

Toolbar:



CREATE PATTERN! command (Pattern menu)

Use this command to generate a pattern for the image.    The configure pattern dialog will 
come up.

You will be able to specify how detailed you want the pattern to be, the smallest piece size, 
and the smoothness of the outlines.

If your image is large (greater than 60000 pixels), you will be asked whether you would like 
to resample the image down to a smaller size.    Because PhotoPat averages colors, the 
process does not generally require a large bitmap to create a suitable pattern.

Shortcuts

Toolbar:



Design Pattern command (Pattern menu)

Use this command to design how the pattern looks.    The Pattern Design Dialog will come up.
In it you can change any of the following:

Outlines
Whether Outlines of pieces are displayed
Color of the outlines
Line style of the outlines

Identifiers
Whether Identifiers of pieces are displayed
Color of the identifiers
Font of the identifiers -Identifiers can also be drawn in the color of their respective piece.
Whether identifiers indicate colors or pieces. (Pieces can be numbered from smallest to 
largest, or from largest to smallest)

Pieces
Whether the pieces are displayed

Background
Whether a background is displayed
Color of the background

Grid
Spacing of the horizontal grid lines
Spacing of the vertical grid lines
Whether horizontal grid lines should start at the top or bottom
Whether vertical grid lines should start at the left or right
Color of the grid lines

Shortcuts

Toolbar:



Save Pattern As command (Pattern menu)

Use this command to save the pattern into one of several formats.

bmp Windows Bitmap format
plt HPGL graphics format
dxf AutoCad data exchange format



Statistics command (Pattern menu)

Use this command to display statistics about the created pattern.    Information includes the 
number of pieces and the number of colors used.    More detailed information can be found in
some of the Reports.



New command (Palette menu)

Use this command to create a new palette.



Open command (Palette menu)

Use this command to open an existing palette.

Shortcuts

Toolbar:



Edit command (Palette menu)

Use this command to edit the current palette.

Shortcuts

Toolbar:



Print command (Palette menu)
Use this command to print the current palette.    The palette report contains the palette ids, 
descriptions, and color definition.



Save command (Palette menu)

Use this command to save the current palette.



Save As command (Palette menu)

Use this command to save the current palettewith a new file name.



Palette command (Reports menu)

Use this command to generate a report of the palette.    The report shows the color 
identifiers, the color names and the red-green-blue components.



Colors command (Reports menu)

Use this command to generate a report of the colors used in the pattern.    The report shows 
the color name, the number of pixels using that color, and the percentage of total pixels 
using that color. 



Pieces command (Reports menu)

Use this command to generate a report of the pieces in the pattern.    The report shows the 
pieces, the number of pixels in that piece,    and the piece's percentage of the total design.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons Command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

PhotoPat displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Registration
The author of this program is a member of the Association of Shareware Professions (ASP).

PhotoPat 1.5 is a shareware product.    As such, it is provided to you at little or no initial 
expense for a trial period of 30 days.    After the 30 day period if you find that you do not 
wish to purchase the program simply delete it from your hard disk and/or floppies.    If like 
the program, thank us by sending a check for $25.    It is not free.    We have spent a great 
deal of effort in putting this program and concept together.    Your registration will ensure 
continuing innovative products like this, as well as helping to support the shareware 
concept.

Mail your check for $25(per registration) ($22 + $3 postage, material, and handling) to:

Rainbow Scan, Inc.
135 Beech Lake Court
Roswell, Georgia    30076

Also as described below, you are entitled to 2 complementary scans of photographs.    
(Additional scans are $6 each).

Feel free to print this topic as a registration form, and complete the following:

Name :
Address :
City :
State :
ZIP :
Daytime Phone Number :
Evening Phone Number:

Your registered version will come on high density 3.5 diskettes.

Registration entitles you to the following:

+ Custom registered version with no more registration reminder screens or 
"unregistered version" text appearing on your printouts!.

+ A printed User's Guide.

+ More sample bitmaps and palettes. 

+ A useful screen saver for your bitmaps and patterns!!

+ Three months of support via mail, telephone (404) 642-7515, and CompuServe 



(75027,3674).

+ Information on upcoming releases, bug notices, scanning services, and design 
contests!!

+ Two free scans of your favorite photographs so that you can use them with 
PhotoPat.    Simply send them along with your registration.    If there are any special cropping 
instructions, attach a note.    They will be scanned at a standard resolution and be suitable 
for use in PhotoPat as well as for Windows wallpaper, screen savers, and other graphics 
programs which accept BMP files.    They will be returned to you with your registered version.

+ Low cost scans of photographs and drawings.    Aside from the 2 complementary 
scans mentioned above, Rainbow Scan, Inc. will make additional scans at a very low price: 
only $6 each.    

Please send us any suggestions you might have for improvements, palettes, and new 
features.    We'd also like to hear about how you might be using PhotoPat.    Your comments 
are very important to us.

You may copy this program and share it with others, but you may not sell the software.    For 
more information, refer to the distribution topic.



Distribution of PhotoPat

You may copy this program and share it with others, but you many not sell the software.    
Anyone wishing to charge people a fee for giving them a copy of PhotoPat must have the 
written authorization of the author and/or Rainbow Scan Inc., without which, the distributor 
is guilty of copyright violation.    To receive such authorization, print and sign the agreement 
listed below and send it to me at the address listed above.    Include $3 to cover postage and
handling for the latest version of PhotoPat.    For distributors already recognized by the 
Association of Shareware Professionals, this authorization is not necessary.

TERMS OF DISTRIBUTION OF PHOTOPAT

1. The fee charged may not exceed $10, including postage, material, mailer, and any other 
charges.

2. Your libraries catalog or listing must state that this program is not free, but is copyrighted 
software that is provided to allow the user to evaluate it before paying.

3. The offering and sale of PhotoPat will be stopped at any time the author and/or Rainbow 
Scan, Inc. so requests.

4. Copies must be made from the disk sent to you with this agreement.    This is required for 
control purposes.

5. Problems or complaints about the program will be reported to the author for investigation. 
In return for a license to charge a fee for the distribution of the program PhotoPat, I agree to 
comply with the above terms of distribution.

Signed ___________________________                                    ___________________
                                          your signature                                                                                        date



Disclaimer

This software and other distributed materials are sold as is and without warranties as to 
performance of merchant ability or any other warranties whether expressed or implied.    
Because of the various hardware and software environments into which this program may be
put, no warranty of fitness for a particular purpose is offered.    Any program should be 
thoroughly tested with non-critical data before relying on it.    The user must assume the 
entire risk of using the program.    Any liability of the seller will be limited to product 
replacement or refund of purchase price.



Shareware

This program is produced by a member of the Association of Shareware Professionals (ASP).   
The ASP wants to make sure that the shareware principle works for you.    If you are unable 
to resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for member's 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon MI 49442 or 
send a CompuServe message via CompuServe Mail to ASP Ombudsman    70007,3536.

Shareware distribution gives users a change to try software before buying it.    If you try a 
Shareware program and continue using it, you are expected to register.    Individual programs
differ on details -- some request registration while other require it, some specify a maximum 
trial period.    With registration, you get anything from the simple right to continue using the 
software to an updated program with printed manual.    Copyright laws apply to both 
Shareware and commercial software and the copyright holder retains all rights, with a few 
specific exceptions as stated below.    Shareware authors are accomplished programmers, 
just like commercial authors, and the programs are of comparable quality.    (In both cases, 
there are good programs and bad ones!)    The main difference is in the method of 
distribution.    The author specifically grants the right to copy and distribute the software, 
either to all and sundry or to a specific group.    For example, some authors require written 
permission before a commercial disk vendor may copy their Shareware.    

Shareware is a distribution method, not a type of software.    You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware.    The Shareware 
system makes fitting your needs easier, because you can try before you buy.    And because 
the overhead is low, prices are low also.    Shareware has the ultimate money-back 
guarantee -- if you don't use the product, you don't pay for it.



Credits

A special credits screen can be found "Easter-egg" style, somewhere off the About box!!



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using PhotoPat and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



Search for Help On... command (Help menu)

Use this command to look for help topics based on key words.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
PhotoPat 1.5.



Context Help command 

Use the Context Help command to obtain help on some portion of PhotoPat.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the PhotoPat window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (Control menu)

Use this command to reduce the PhotoPat window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (Image Control menu)

Use this command to switch to the next open image window.    PhotoPat determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Close command (Control menu)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes an image window

ALT+F4 closes the PhotoPat window or active dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Choose Font dialog box

The Font Dialog allows you to customize the font used to display the identifiers.    You can 
select from any font installed on your system.    You can change the style, size, and various 
effects like strikeout and underline.



Choose Color dialog box

The Choose Color Dialog allows you to precisely define a color used in the palette.    You can 
choose a basic pre-defined color, or define your own.    Colors can be defined by either a hue-
saturation-luminous color space or a red-green-blueHID_RGB color space.

In addition to the color, the Choose Color Dialog lets you set the identifier and name for the 
color.    The identifier is used on the pattern to identify the color.    The name is displayed on 
the palette report.

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.



File Save As dialog box

The following options allow you to specify the name and location of the image file you're 
about to save,

Dialog box items

File Name
Type a new filename to save an image with a different name.    A filename can contain up
to eight characters and an extension of up to three characters.    PhotoPat adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the image.

Directories
Select the directory in which you want to store the image.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Brightness Contrast dialog box

Dialog box items

Brightness
Allows you to change the brightness from all white to all black

Contrast
Allows you to change the contrast from a minimum to maximum.

Preview
Allows you to view the brightness/contrast adjustments before actually changing 

them.



Grid Design dialog box

Dialog box items

Vertical

Starting on the left/right 
Vertical grid lines can be placed starting on either the left or right side.

Minor Lines every _ pixels
Minor vertical grid lines are spaced by this number of pixels.    If this value is 0, no 

vertical lines are drawn.

Major Lines every _ minor lines
A single major vertical grid line is drawn instead of a minor grid line, this number of 

minor lines.    If this number is 0, no major vertical lines are drawn.

Horizontal

Starting on the top/bottom 
Horizontal grid lines can be placed starting on either the top or bottom side.

Minor Lines every _ pixels
Minor horizontal grid lines are spaced by this number of pixels.    If this value is 0, no 

horizontal lines are drawn.

Major Lines every _ minor lines
A single major horizontal grid line is drawn instead of a minor grid line, this number 

of minor lines.    If this value is 0, no major horizontal lines are drawn.

Major Lines

Color
Allows you to select a color for drawing major lines

Style
Allows you to select a line style line style for drawing major lines

Minor Lines

Color
Allows you to select a color for drawing minor lines

Style
Allows you to select a line style line style for drawing minor lines



Pattern Design dialog box

Dialog box items

Outlines

Display Outlines 
Select whether you want the piece outlines to be drawn.    The outlines show 

how the pieces are laid out.

Color 
Select one of a predefined set of colors to use when drawing the outlines.

Style
Select one of a predefined set of line styles to use when drawing the outlines.

Background

Display Background 
Select whether you want a background drawn.    A background sets the display

to a solid color prior to drawing the rest of the pattern.    It is helpful when you want to view 
the outlines by themselves, rather than on top of the original image.

Background Color
Select one of a predefined set of colors to use when drawing the background.

Grid

Display Grid
Select whether you want a grid to be drawn.    A grid is helpful in laying out the

pattern and transferring the pattern to different materials.

Design Grid
Brings up the Grid Design dialog which lets you customize features of the grid 

(spacing, color, line type).

Identifiers

Display Identifiers
Select whether you want the piece identifiers to be displayed.

Color
Select one of a predefined set of colors to 

use when drawing the identifiers.

Mapping
Select the mapping used to determine the text of identifier.

Identifier Font
Selecting this button will bring up the Choose Font dialog.    This font will be 

used when drawing the identifiers.

Pieces



Display Pieces
Select whether the pieces (areas within outlines) are drawn using the palette 

colors.    Each piece is drawn in palette color assigned to it.

Colors
Show All Colors

Selects all of the colors listed in the "Colors to show" list box. Hence all pieces 
will be displayed.

Show No Colors
Selects none of the colors listed in the "Colors to show" list box.    Hence none 

of the pieces will be displayed.

Colors To Show
This multiple choice list box allows you to select only the colors of pieces you 

want to see.    The list box contains only those colors from the palette that were used in the 
pattern.

Default Changes the values in this dialog box (as well as the grid and font 
selections dialogs) to default values.



Pattern Statistics dialog box

Number of Pieces
Displays the number of created pieces in the pattern

Number of Colors
Displays the number of colors from the palette used in the pattern.

Palette Name/Desc
Displays the name of the palette (and its description) used to create the pattern.



Resample dialog box

Dialog box items

X resolution
Displays the X (horizontal) resolution of the original image.

Y resolution
Displays the Y (vertical) resolution of the original image.

Uniform Resampling
Selecting this option will force the resampling percentage to be the same in both X 

and Y.    This will keep the aspect ratio of the original image the same in the new image.    
Turning this option off, will cause "stretching" in the new image.

X%
This sets the percentage of resampling in the X (horizontal) direction.

Y%
This sets the percentage of resampling in the Y (horizontal) direction.

New X Resolution
This sets the final X (horizontal) resolution in the new image.

New Y Resolution
This sets the final Y (vertical) resolution in the new image.

Quick/Accurate
This controls the method used to do the resampling.    Either a quick method or a very

accurate method can be applied.    In most cases with PhotoPat, the Quick method is 
adequate.

Note: The amount of resampling can be set by either changing the resampling percentage or
setting the final resolution.    Both are interrelated; changing one will change the other.    You 
have the flexibility to use either to determine the amount of resampling.



Image Info dialog box

Name of Image
Disk name and location of the image file.

X resolution
X (horizontal) resolution of the image file.

Y resolution
Y (vertical) resolution of the image file.

Compression
Whether the image was originally in a compressed bitmap format. 

# of Bits per pixel
The number of bits/pixel in the original image file.    The more bits per pixel, the more 

colors a pixel can represent.    For example with 1 bits/pixel, each pixel's color can be one of   
2^1=2 colors; with 8 bits/pixel each pixel's color can be one of 2^8=256 colors.

X DPI
The number of X (horizontal) dots-per-inch in the image file.    This is usually set when

the image gets created (e.g. by scanning at a particular dpi)

Y DPI
The number of Y (vertical) dots-per-inch in the image file.    This is usually set when 

the image gets created (e.g. by scanning at a particular dpi)

File Type
The original file type of the image file (e.g. BMP, PCX) 

Size
The size (in bytes) of the image file.    This includes header information, the color 

table, and the pixels.

Modified
Whether the image file has been modified in PhotoPat from its original (on disk) form.



Palette Design dialog box

This dialog is used to design colors in the palette.

Color Buttons
Color shown is the color assigned to that palette slot. 

Buttons are laid out in slot order.

The button is labeled with the identifier assigned to that palette slot.

Color is enabled if no "X" appears on the button.    Color is disabled if an "X" appears on the 
button.

The current slot is indicated by a bold border.

Add Color
Adds a new color at the next available slot.

Insert Color
Inserts a new color before the current slot.

Enable All
Enables all of the colors.    All of the colors will be available for the next generated 

pattern.

Disable All
Disables all of the colors.    None of the colors will be available for the next generated 

pattern.
 
Note: Enabling/Disabling of colors is useful when you have a standard palette of colors, but 
are temporary "out" of a particular color.



Pattern Configuration dialog box

This dialog is used to configure the pattern generation process.

Dialog box items

Pattern Quality
Defines how detailed you want the pattern to be.    Choices for pattern quality are 

simple, medium, detailed, and complex.

Smallest Piece Size
Allows you to specify how small (in pixels) you want the smallest piece to be.    This 

size does not apply in detail areas.

Curve Degree
Defines how smooth you want the piece outlines to be.    Choices for curve degree are

straight, smooth, and very smooth.

Default
Sets all values in this dialog to their default values.

If a detail area is defined, you can also specify the following:

Process using Detail Areas
Allows you to choose whether to apply special processing to detail areas.    If detail 

areas are processed, pieces in them will be formed with a smaller-color tolerance.    
Generally more pieces will be created in detail areas.

Smallest Detail Area Piece Size 
Allows you to specify (in pixels) how small you want the smallest piece in the detail 

area to be.    This may and should be smaller than the smallest piece size 



Print Choices dialog box

This dialog is used to select which items to print.

Dialog box items

Information

Pattern
Print the pattern.    This item is only active if there is a pattern generated.

Pattern-Color Separated
Print the pattern, one color per page.    On each page only the pieces for that color 

will be printed.    This is useful when you need to separate out the colors in the pattern.    This
item is only active if there is a pattern generated.

Image
Print the image.    This item is always active.

Palette
Print a report of the colors in the palette.    The report contains the color names, 

identifiers, and RGB components.

Piece Report
Print a report of the pieces in the pattern..    The report shows the pieces, the number 

of pixels in that piece,    and the piece's percentage of the total design.

Color Usage Report
Print a report of the colors used in the pattern.    The report shows the color name, the

number of pixels using that color, and the percentage of total pixels using that color.

Size

1 to 1
Each pixel in the image/pattern is mapped to a single dot on the printer.    The aspect 

ratio of the image/pattern is preserved.

Actual Size
DPI (dots per inch) information in the image/pattern is used in scaling so that the 

printed image is the same size as the original image.

Fit to Page
The image/pattern is scaled so that the printed image will fill a single printer page.

Scale
The image/pattern is scaled so that any size output (including poster size) can be 

generated. Note that 100% scaling is equivalent to the 1 to 1 size.

Hint: When using the HPLJ printer, select the "Print Truetype as Graphics" option to allow for 
precise clipping of text on poster size output.

Scale Ids
For patterns, you can choose to scale the size of the piece identifiers as well 



as the pattern.    Usually you want to keep the size of ids as small as possible, so the default 
for this option is no scaling.

Width
Displays the X (Width) size of the to-be printed image/pattern.

Height
Displays the Y (Height) size of the to-be printed image/pattern.

Units
Allows you to view the Width and Height in different units (inches, points, 

centimeters, and pixels).

Labeling

Title
A title is printed at the bottom center of the image/pattern.    You can enter any text 

to used for the title.

Tag
A tag is printed at the bottom left of the image/pattern.    You can enter any additional

information (e.g. Date, Palette, etc.) to be used for the tag.

All
Selects all of the information selections to be printed.    This option is only available if 

a pattern has been generated.



File Open dialog box

The following options allow you to specify which image file to open:

Dialog box items

File Name
Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of image file you want to open:
BMP - (Windows 3.1 Bitmap format) - 256 Colors
PCX - (ZSoft PC Paintbrush format) - 256 Colors

Drives
Select the drive in which PhotoPat stores the image file that you want to open. 

Directories
Select the directory in which PhotoPat stores the image file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

Shortcuts

Toolbar:
Keys: CTRL+O



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in PhotoPat,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    PhotoPat displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, PhotoPat displays the Save As dialog box.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Print the active document.

Generate a Pattern for the Image.

Rotate image 90 degrees counterclockwise.

Rotate image 180 degrees.

Rotate image 270 degrees counterclockwise.

Flip the image about its horizontal center.

Flip the image about its vertical center.

Zoom in to the image.

Display the image at 100%.



Zoom out of the image.

Undo the last change to the image.

Edit/display the current palette.

Crop the image

Turn the display of the image on and off

Turn the display of the pattern on and off

Bring up PhotoPat's About Box

Bring up Context Sensitive Help



Status Bar

The status bar is displayed at the bottom of the PhotoPat window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Brightness

Brightness describes the overall lightness and darkness of the image.    Brightness ranges 
from all black to all white



Contrast

Contrast describes the distribution of lightness and darkness in the image.    Contrast ranges 
from min (gray) to max (full color differential).



Pattern Quality

Pattern Quality can be set to the following:

Simple Max of 100 
Pieces

Medium Max of 300 
Pieces

Detailed Max of 500 
Pieces

Complex Max of 700 
Pieces

The exact number of pieces in the pattern can be found in the statistics dialog.



Line Styles

The following line styles are supported:

Thin solid
Thin dash
Thin dot
Thin dash-dot
Thin dash dot 
dot
Light solid
Thick solid
Heavy solid

Graphic representations of the line styles appear in the list boxes.



Predefined Colors

The following colors are predefined for use in displaying patterns:

Color Name Red Gree
n

Blue

Black 0 0 0
Blue 0 0 255
Green 0 255 0
Cyan 0 255 255
Red 255 0 0
Magenta 255 0 255
Yellow 255 255 0
White 255 255 255
Gray 127 127 127
Light Blue 100 100 255
Light Green 100 255 100
Light Cyan 100 255 255
Light Red 255 100 100
Light Magenta 255 100 255
Light Yellow 255 255 100
Light Gray 200 200 200

Colors are represented in an RGB color space.
.



Curve Degree

The piece outlines can be computed to one of 3 precisions:

Straight Outlines are straight (linear) lines, 
exactly matching the pixel edges.

Curved Outlines are approximations to quadratic
bspline curves.

Very 
Curved

Outlines are approximations to cubic 
bspline curves. 

Bsplines are curves which are numerically defined as piece wise polynomials (order 2= 
quadratic, order 3= cubic).    Because most drawing and printing devices accept only straight
lines, PhotoPat approximates these curves as straight lines when it creates the pattern.    In 
many cases, over 150 lines are used to draw a curve separating two pieces. 

Although the difference between using straight lines and curved lines is obvious, the 
difference between using curved and very curved lines may not be.    In some cases very 
curved lines may result in a "truer" looking pattern.



RGB - Red Green Blue Color Space

A RGB (Red, Green, Blue) Color Space has 3 axes (one for Red, one for Green, and one for 
Blue).    The values along each axis range from 0 (no component) to 255 (full component).    
RGB coordinates for some common colors are follows:

Color Red Green Blue
Black 0 0 0
White 255 255 255
Red 255 0 0
Green 0 255 0
Blue 0 0 255
Yellow 255 255 0
Cyan 0 255 255
Magenta 255 0 255
Gray 127 127 127

Grid

A grid is a set of horizontal and vertical lines which is created as part of the pattern.    It can 
be toggled on and off.    The grid has major and minor lines in both directions which serve to 
easily provide dimensions to the pattern.    Spacing, colors, and line types for the grid are all 
customizable. 



Piece Identifiers

Piece Identifiers (ids) are used to label the pieces.    The character font for the identifiers is 
customizable (font, size, etc.).    Any Windows font can be used.    The color for the identifiers 
is also selectable.

The mapping for the identifier can be one of the following

The Palette Id of the color used for that piece.
The numerical size order of the piece (in either ascending order or descending order).



 Identifier Mapping

Identifiers are used to label the pieces.    The text for the identifiers (ids) is determined by 
the mapping selected.

The mapping for the identifier can be one of the following

The Palette Id of the color used for that piece.    Refer to the palette itself for the 
current palette ids defined.    Each color in the palette can have an identifier of up to 10 
characters.

The numerical size order of the piece (in either ascending order or descending order).
For example in a pattern of 10 pieces in ascending order the largest piece will have an 
identifier of "10" and the smallest piece will have an identifier of "1".



 Units

Here are some useful conversions between inches, centimeters, points, and picas all of 
which are occasionally used for printing units:

1 inch(in) = 1.00 in = 2.54 cm = 72 pt = 6 pi
1 
centimeter(cm)

= 0.39 in = 1.00 cm = 28.08 p = 2.34 pi

1 point(pt) = 0.0139 
in

= 0.0355 
cm

= 1.00 pt = 0.0834 
pi

1 pica(pi) = 0.167 in = 12 pt = 1.00pi = 1.00pi



 HPGL

HPGL (Hewlett Packard Graphics Language) is a defacto standard for plotting devices.    
When PhotoPat generates an HPGL file, it uses the following HPGL commands:

IN Initialize Plotter
SP Select Pen

Pen 1 - used for piece outlines and identifiers
Pen 2 - used for grid

PA Pen Absolute mode
LT Line Type 

-1 Solid
 0 dot at each coordinate
 1 dotted
 2 dashed
 3 long dashes
 4 dash-dot
 5 long dash, short dash
 6 long dash, short dash, short dash

PT Pen Thickness (in millimeters)
SI Absolute Character Size (in millimeters)
PU Pen Up
PD Pen Down
LB Label

Note: PhotoPat assumes 500 plotting units per inch and outputs to a paper size of 8.0 x 10.5 
inches.



Revision History

Version 1.0 - Release Date: August 14, 1994
1. Original Version

Version 1.5 - Release Date: September 30, 1994
1. Allowed for patterns to be separated by colors.
2. ASP acceptance
3. Allowed X/Y to be directly changed in resampling.
4. Incorporated quick resampling
5. Allowed for scaling, 1-1, and actual size printing.

6. Supported HPGL and DXF for vector output.
7. Added Help buttons to most of the dialogs.
8. Allowed for configurable Major and Minor lines in the grid.
9. Increased maximum size of user palette to 240 colors.
10. Fixed problem with sharpen filter

11. Allowed for enabling/disabling of palette colors.
12. Expanded Image/Info display.
13. Allowed for up to 30 undo operations.
14. Displayed pattern statistics.
15. Added Palette Save and Save As as menu selections

16. Improved font selection and scaling.
17. Automatically ask to resample when creating patterns with large images.
18. Changed wording of Curve degree listbox.
19. Displayed the zoom percentage and image/pattern indicator in Image Window Titles
20. Added image on/off and pattern on/off buttons.

21. General 1.0 to 1.5 changes.



AutoCAD DXF

AutoCad DXF (drawing interchange file) format is a standard ASCII file format for transferring
CAD/line graphics files.

PhotoPat uses the following DXF commands:

Line Types:
Continuous
Dash
Dot
DashDot
DashDotDot

Layers:
Outlines
Identifiers
Minor Grid Lines
Major Grid Lines

Entities:
Polyline
Line
Vertex
Text

Notes: 
The drawing size is set to 8.0 x 10.5 inches.
The version set is AC1009.



Title Bar

The title bar is located along the top of a window.    It contains "PhotoPat", the name of the 
image file (path excluded), the current zoom percentage, and whether the image, the 
pattern for the image, or both are currently being displayed.

To move the image/pattern window, drag the title bar.    Note: You can also move dialog 
boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the image window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the image.    You can use the 
mouse to scroll to other parts of the image.






